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Sammanfattning

Detta ar ett examensarbete som beskriver processen for att stélla in
webbservern i Siemens S7-300 och i S7-1200. Vidare beskrivs hur en
applikation i Android utvecklas for att ansluta till PLC och sedan l&sa av och
skicka information. Det ar pa begéran av AF som Metod kapitlet skrivits som
en steg—for—steg manual for att enkelt kunna upprepa samma projekt och fa
liknande resultat.

For att kunna kommunicera med PLC sa har alla steg gjorts i rapporten och
mobiltelefonen har kunnat starta och stoppa en motor samtidigt som den l&st
av dess varden.

Applikationen ar avsedd att séljas av AF som en tjanst for deras kunder. Ett
fast pris kunde inte sattas pa applikationen da PLC program varierar i storlek.
Varje applikation maste skraddarsys efter ett PLC program. Den integrerade
webbservern valdes for att det var det billigaste alternativet for att upprétta en
kommunikation mellan mobiltelefon och CPU. | rapporten beskrivs alternativa
metoder till webbservern.

Nyckelord: Siemens S7-300/1200, Android, Integrerad Webbserver, TIA
Portal V11, Step 7, PLC



Abstract

This is a thesis that describes the procedure for setting up the web server on
Siemens S7-300 and S7-1200. It also describes how to develop an application
on Android to connect to the PLC and then read and send information. It is on
the request of AF that the Method chapter is written as a step — by — step
manual for easy repeat of the project and to get similar results.

To communicate with the PLC, all steps in the report have been made and the
mobile phone has been able to start and stop a motor while reading its values.

The application is intended to be sold by AF as a service to their customers. A
fixed price could not be decided because the PLC program is varying in size.
Each application must be tailored to a PLC program. The integrated web
server was chosen because it was the cheapest option for establishing the
communication between the Smartphone and the CPU. The report describes
alternative methods to the web server.

Keywords: Siemens S7-300/1200, Android, Integrated Web server, TIA Portal
V11, Step 7, PLC
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1 Inledning
| detta kapitel beskrivs bakgrund, syfte och avgransning for examensarbetet.

1.1 Bakgrund

Detta examensarbete ar skrivet i AF som é&r ett ledande teknikkonsultféretag
som erbjuder kvalificerade ingenjorer med l6sningar for industrins processer.
Uppdragen skiftar mellan olika omraden sa som fran utveckling av
mobiltelefoni till projektering. Med bas i Europa och kunder runt om i vérlden
har AF cirka 6800 medarbetare [1].

Projektet var pa eget initiativ och skulle omfatta en applikation som styr en
motor men Peter Bjorklund, Area Manager i Helsingborgskontoret,
omformulerade idén till att istallet gora en applikation till en Siemens PLC
som styr en motor eller en pump. En sadan applikation kan bli ett anvandbart
verktyg pa arbetsplatsen som ger en 6verblick pa vad som ar igang eller pa
vad som star still. Den kan underlatta for ansvariga operatérer att felsoka i en
maskin och minska kostnaderna for foretagen da applikationen meddelar nar
en maskin ar ur funktion. Operattdren kan &ven starta och stoppa en maskin
med telefonen utan att befinna sig i samma rum. Det kan vara nédvandigt om
nagot varde inte stammer och bor kontrolleras.

Anledningen till att en mobilapplikation valdes vid styrning av PLC var att
anvandning av smarta mobiltelefoner har bland Sveriges invanare ¢kat fran 30
% till 50 % fran aren 2011 till 2012 enligt frapps.se [2]. Enligt den statistiken
s& har hilften av Sveriges invanare en “smartphone” som kan utnyttjas pa
arbetsplatsen till mer an bara samtal.

1.2 Syfte

Syftet med denna rapport ar att undersoka Siemens mojligheter att
kommunicera tradlost med en Android mobiltelefon. Metoden i denna rapport
skall enligt begaran fran AF Industry kunna anvandas som en lathund for hur
webbservern aktiveras, variabler lankas och hur en Android applikation skapas
och ansluter till PLC. Metoden delas in i manga delkapitel da det gor det
lattnavigerat for en anvandare som foljt stegen att ga tillbaka vid felsékning.

Syftet med detta projekt &ar inte att skriva PLC kod for en motor som i
exemplet som ndmns i kapitel 4 Metod. Darfér skrivs inte all kod ut for
motorexemplet.



1.2.1 Fragestallningar

e Kan en Androidbaserad mobiltelefon kommunicera med Siemens PLC
S7-12007?

e Ardet mojligt att lasa av varden?
e Tilldela nya vérden?
e Skriva ut alarm status?

e Kan samma teknik anvandas for att kommunicera med Siemens PLC
S7-300/4007?

1.3 Avgréansning

Applikationen kommer att programmeras i Eclipse med Java for Android da
detta ar en 6ppen plattform. Detta for att vi redan ar bekanta med utveckling
av Android — applikationer.

AF ansdg att det var mest intressant att kunna kommunicera med Siemens
PLC S7-300/400/1200.



2 Verktyg

Har beskrivs de hjalpmedel som anvants for att kunna utféra detta projekt.

All programmering, nedladdning och éverforning utfordes fran Windows XP
som kors pa en PC, DELL D820.

2.1 Mjukvaruprogram

2.1.1 Eclipse

Eclipse &r en kostnadsfri utvecklingsmiljo som bildadesi januari
2004avEclipsestiftelsesom en oberoendeicke-vinstdrivande bolag for
attfungera som forvaltare avEclipsesamfundet. | Eclipse utvecklas
programvara och projekti flera olika sprak sdsom Java, C, C++ och Python.
Det finns i svenska och ar tillganglig forde flesta plattformar. Det gar dven att
installera olika plug-in for Android och Webbservrar[3].

2.1.2 Android SDK

Android SDK ar en verktygslada som utvecklare anvander for att skapa
applikationer for Android-plattformen. Den innehaller en emulator och
nodvandiga bibliotek for att kunna bygga Android — applikationer. Nar
Android SDK 4&r installerad i Eclipse som ett plug-inar det mgjligt att utveckla
Javaapplikationer for Android. Android SDK erbjuder dven grafiskt
anvandargranssnitt vilket gor det vanligt for utvecklarna att kunna fa en
overblick av layouten och designen av deras applikation[4].

2.1.3 TIA Portal v11

Totally Integrated Automation Portal ar det senaste programmet som Siemens
har utvecklat for S7-1200 familjen.Den ersétter foregangaren SIMATIC
Manager. | TIA Portal vl1skapas alla projekt och kodas i samma program.
Programmet klarar de olika programmeringstyperna, LAD, STL ochFBD. Allt
ar integrerat i TIA Portal v11, en anvandbar funktion dr ”’Go Online” déar far
anvandaren en 6versikt av programmet. Ingangarna lyser gront nar de ar till
och rott nar de ar fran. Detta ger en méjlighet for anvandaren att simulera
programmet innan den laddas ner i PLC.

2.1.4 SIMATIC Manager

SIMATIC Manager &r ett program som Siemens automation har utvecklat for
konfigurering av instéllningar for alla SIMATIC produkter. | Step 7 sa kodas
programmet som sedan skall kdras och fors 6ver till Siemens PLC S7-
300/400. SIMATIC Manager later programmeraren koda sitt projekt,
konfigurera hardvaran, korrigera symboler och slutligen ladda ned projektet
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till PLC. | SIMATIC Manager finns det en funktion som gor det mojligt att
testa sin kod genom att ga “online” och fa en oversikt av exekvering av koden
I runtime.

2.1.5 Notepad++

Notepad++ &r ett konstadsfritt program som ar framstallt for Microsoft
Windows operativsystem. Det &r ett textredigeringsprogram for kodning av
HTML, PHP, JavaScript samt en del andra sprak. Notepad++ ar kodad i C++
och &r mycket kraftfull vid kompilering av projekt. Utvecklarna bakom
programmet forsoker anvanda sa lite sa mojligt av CPU kraften vid
kompilering och dérmed resulterar det hela till stabilare och snabbare program

[5].

2.2 Programmeringssprak

Har beskrivs de programmeringssprak som anvandes for kommunikation och
design.

2.2.1 HTML

“Hyper Text Markup Language” eller den kidnda forkortningen HTML ar
koden som anvands vid skapandet av webbsidor. Med HTML kan en hemsida
kodas och visas pa en webblasare. Den forsta versionen av HTML lanserades
redan 1991 och sedan dess har det sldppts 7 versionerdar den senaste ar
XHTML5(ar 2013). Syntaxen for HTML ar féljande:

<IDOCTYPE htmi>
<html>

<head>

</head>

<body>
<h1> Rubrik </h1>
<p> Paragraf, med andra ord ren text. </p>

</body>
</html|>

HTML é&r ett marksprak, det vill séga att det kodas med hjélp av
vinkelparenteser. En instruktion uppkommer normalt 1 par till exempel ~<p>
text </p>". Den borjar med vinkelparenteser och avslutas med snedstreck for
att tala om for webbl&saren var en instruktion borjar och slutar. For att en
hemsida skall visas korrekt pa webblasaren s maste webblasaren veta



webbsidans dokumenttyp och vilken version den har. Det gors med féljande
deklaration: ”<IDOCTYPE html> "(se syntaxen ovan). Eftersom dér finns det
manga olika dokument pa webben sa ar denna deklaration nédvandig.
Webblasarna visar inte vinkelparenteserna utan bara det som star mellan de.
Daremot &r vinkelparenteserna avgorande for webblasaren da de talar om for
webblasaren hur innehallet skall visas.

Mellan ”<head></head>" taggarna skrivs all nodvandig information for
webblédsaren. Det ar dar JavaScripts eller CSS filer inkluderas, hemsidans titel
samt en del annan information som har med funktionalitet att géra. Det som
skrivs mellan ”<body></body>" taggarna visas pa webblasaren. Det &r dér all
information laggs in for att kunna framféra det pa webbléasaren. Det gar att
anvanda flera HTML sidor och lanka de med varandra. Att endast anvanda
HMTL kommer inte vara effektivt dd HMTL sidor ar statiska. De kan inte
utféra avancerade berékningar eller nagot liknande. HTML sidor visar endast
innehall pa en sida, daremot kan PHP eller JavaScript anvandas for att kunna
omvandla HMTL sidan till en dynamisksida. Med hjélp av PHP eller
JavaScript kan vanliga uttryck sasom “for”, ”while”, if” och “’switch-case”
utnyttjas [6].

2.2.2 CSS

W3C skapade Cascading Style Sheets, CSS , for att underlatta fér utvecklare
att designa webbsidor. CSS — filen &r en separat fil dar bl.a. storlek och farg
bestams pa webbsidan. CSS — filen inkluderas inom "<head></head>" i
HTML — filen sasom nedan.

<link rel="stylesheet" type="text/css" href="mystyle.css">

For mindre webbsidor med latt design kan koden for design och layout goras
direkt inom "<head></head>" och ingen separat CSS — fil behovs.

[7].

2.2.3 Java

Java dr ett objektorienterat programmeringssprak som introducerades 23 maj
1995 av grundaren James Gosling pa Sun Microsystems. Java finns fran
superdatorer for forskningsandamal till effektiva mobil applikationer. Detta
sprak ar plattformsoberoende pa grund av att Java kompilerar sin kod till
bytekod istallet for maskinkod. Den fardig kompilerade bytekoden kan i
efterhand koras pa en plattformsoberoende maskin.

Mer an 9 miljoner utvecklare anvander idag spraket Java vilket gor att Java ar
testat och utvecklat for att uppfylla utvecklarens forvantningar och mal [8].



2.2.4 JavaScript

JavaScript ar ett av varldens mest populéra programmeringssprak for HTML,
webb applikationer, datorer, mobiltelefoner och for serverar. JavaScript
omvandlar en HTML sidan fran att vara en statisk till dynamisk med
avancerade funktioner. JavaScript ar snarlikt Java och C++. Det & mojligt att
anvanda samma uttryck som i Java och C++; ”for”, ”while”, ”if” och ”’switch
case”. Med dessa funktioner tillgangliga underldttas HTML kodningen och det
funktionaliteten okar for en hemsida som utnyttjar JavaScript. FoOr att kunna
anvanda JavaScript i HTML krévs att det anropas pa ratt satt, det vill saga att
”<script> JavaScripts kodning </script>" miste skrivas inom “<head>" eller
”<body>" delen.For tydlighetens skull sa brukar de flesta programmerare ha
JavaScripten i en sérskilt fil och anropar den i1 ”<head>" som foljande syntax:
“<script src="filNamnet.js" type="text/javascript"></script>"

Men for mindre webbsidor ar det vanligt att JavaSripten utnyttjas direkt i
”<body>" eller ”<head>" delen. Alla dagens webbl&sare klarar av att kdra
JavaScript och de &r anpassade till det [9].

2.3 Materiellista

= DELL D820

= DELL D830

= Ethernet — kabel

= Frekvensomvandlare

= Motor

= Dlink Router

= Siemens S7-300 CPU 314C-2 PN/DP
= SiemensS7-1200 CPU 1212C AC/DC/RLY
= Plintar

=  Kopplingskablar

» Spéanningsomvandlare



3 Metod

Detta kapitel beskriver tillvagagangssattet for att uppna de resultat som
beskrivs i kapitel 5 Resultat. For att kommunicera med bade S7-1200 och S7-
300 anvandes dess inbyggda webbservrar. Nedan foljer information om hur
webbservern aktiveras och hur en webbsida for CPU skapas och anvands som
en Android applikation. | denna rapport anvands CPU 1212C AC/DC/RLY
och S7-314C-2 PN/DPmed programkod for att styra en motor. Alternativa
metoder for denna PLC beskrivs i kapitel 4.2.

Stegen som anges nedan sker i den ordning de presenteras.

3.1 S7-1200

TIA Portal V11 (2.1.3)anvandes for att stélla in webbservern fér CPU S7-
1200.

Detta kapitel kan anvandas som en lathund till hur webbservern aktiveras, for
djupare forstaelse av utvalda punkter hanvisas lasare till kapitel 3.5[16].

3.1.1 Konfigurera S7-1200

e PLC och datorn koppladessamman med en router och tva Ethernet
kablar.

e Ett nytt projekt skapades med TIA Portal V11 SP2.

e FOr att kunna skriva programkod valdes ratt CPU via ”Add new
device”. Vid val av "unspecified” sd viljs ratt CPU automatiskt av
programmet.

e |P adress och subnatfér CPU stalldes in genom installningar iCPU
under projektet. Dar las ett nytt subnét in i ”Ethernet addresses” menyn.
Den IP adress som tilldelades CPU &r samma adress som anvénds vid
anslutning till webbsidan.

e Variabelnamn tilldelades for att binda samman namn och logiska
operatorer samt for att underlatta felsokning da de ar kommenterade.



I”PLC tags”>"Default tag table”korrigeras dessa som i figur 1.

MHame Cata type Address Retain  “isibl...

ACCES. ..
1 | Start Bool 2610.0 =] =] ]
2 < Stop Eool =101 (=] =]
=] <@l Reset Knapp Bool 2610.3 [+ =l
4 < Motorskydd Eool 010,49 (=] =]
] <@ Motorl Boal %G00 [ =]
& < Tag_1 Eool %001 [ =]
7 < AuWE Dint =02 = =]
E} <l AWPStart Bool 26h100.0 [ =]
a < AWFStop Eool 25011 00.1 =] =]
10 @] Tag_z Byte EMEB (=2l (=l
11 < Tag_s Eool =5h11.1 (=] =]
12 <l Alarrm_minne_ok Bool 26M150.0 [ =l
15 < FirstScan Eool =6h11.0 (=] =]
14 @ AlwaysTRUE Bool h 1.2 [+ =l
15 <@ AlwaysFALSE Eool 1.3 [ =]
16 < Clock Byte Eyte =WED = =]
17 @l clock_10Hz Bool 26M0.0 [ =]
15 <@ Clock SHz Eool =5h10.1 = =]
19 @l Clock_2.5Hz Bool MO 2 (=2l (=l
20 < Clock_2Hz Eool =eh10.3 (=] =]
21 <@l clock_1.25Hz Bool MO .4 (=2l )
22 4 Clock_1Hz Eool =h0.5 (=] =]
23 <@ Clock_0.625Hz Bool MO.6 [+ (=l
24 @ clock_0.5Hz Eool 0.7 =] =]
25 - Tag_d4 Bool ki1 7 0.0 [ =]
26 4l Tag_s Eool k11701 =] =]
27 <l Tag_ s Eool =5h1179.0 = =]
28 @l AwPMotorskydd Bool M7 [ )
29 < AWFPMemory Eool =6h15.0 =] =]
an -l AWPMotorl Bool M1 6.0 (=2l )
31 <l AWFReset_Knapp Eool =6h17.0 (=] =]
a2 <@ Tag_7 Bool Eh 1501 [+ (=l
55 @ Tag_s Eool h150.5 =] =]
2t <@ Tag_ 9 Bool eh180.2 (=2 =]
55 @ Star_rermote Eool 1504 =] =]
S6 < Stop_remote Eool =6h150.5 = =]
57 <l Tag_10 Bool 26M181.0 [ =]
55 < Tag_11 Eool =eh151.2 =] =]
39 @] Tag_12 Bool EMTED 6 (=2l (=l

Figurl. Tabell for variabelnamn i TIA Portal V11

e Variabelnamnen i figur 1 anvandes av HTML sidorna. Hur HTML
sidorna skapas beskrivs i kapitel 3.4.1.

3.1.2 Installningar fér webbservern
CPU >"Properties”>" Web server”

e Webbservern och automatisk uppdatering aktiverades.

e | vilken katalog HTML filerna fanns angavs samt valdes index.html”
som startsida. Projektet far sitt namn Motor via ”Application name”.

e Slutligen genererades "Web Control DB” (3.5.1) genom ”Generate
blocks™.

e | CPU >"Properties” >”Protection” sattes ett skrivskydd med
anvandarnamn och lésenord.

3.1.3 Skapa, kompilera och ladda over program tillCPU



e Under "Program blocks” 1 CPU skrevs en del av PLC koden f6r motorn
i Ladder som framgar av figur 2.

%hA150.0

0.0 %1505 w0 "Alarm_minne_ %00
"Star" P_TRIG "Stop_remote" "Stop" ok" "Motor]"
= ——— ik Q /1 /1 { | { }
%1790
Tag_f %001
"Tag_1"
0.0 _( l_'

"Motorl”

%1204
"Start_remote"”
] |
1 T

Figur 2. Programkod for motor (OB1) i TIA Portal V11

e "WWW?” (SFC99) sattes i OB1 (3.5.1).

iR
EN ENO
333 — CTRL_DB LD 2

RET_VAL® "ailP"

"BE EMAD2

Figur 3. "WWW” instruktion i TIA Portal V11

e Nar programmet var skrivet kompilerades den och laddades ner till CPU
genom snabbkommandona Crtl+B (kompilera) och Crtl+L (ladda ner
till CPU).

3.2 S7-300

Step 7 och SIMATIC Manager &r plattformarna for S7-314C-2 PN/DP vilken
anvandes for att implementera programmet[17].

Detta kapitel kan anvandas som en lathund till hur webbservern aktiveras, for
djupare forstaelse pa utvalda punkter hanvisas lasare till kapitel 3.5.

3.2.1 Konfigurera S7-300

e PLC kopplades till datorn med en Ethernet kabel och ett nytt projekt
skapades med SIMATIC Manager. Projektnamnet sattes till
“webmotor” via “File” > "New”.
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e En ny station tillades via ”Insert” > Station” > ”SIMATIC 300
Station”.

e For att konfigurera hardvaran pd CPU dubbelklickades "SIMATIC 300
och dérefter dubbelklickades "Hardware”.

e Under ”Options” > Set PG/PC Interface” valdes " TCP/IP wireless” for
tradlos anslutning.

3.2.2 Konfigurera hardvaran

e Pa hogra sidomenyn dppnades”SIMATIC 3007, "RACK-300" och
”Rail” dubbelklickades.

o Ett nataggregat valdes 1 "PS-300” > PS 307 2A”.

e Rétt CPU(CPU314C-2 PN/DP) valdes under samma meny. "CPU-300"
>”CPU314C-2 PN/DP” > "6ES7 314-6EH04-QABO0” > "V3.3”.

Properties - Ethernet interface PH-10 (RO/S2.2)

General  Parameters l

If & subnet iz zelected,
the next available addreszes are suggested.

IP address: [192.168.0.105 Gateway

" Do ot use router
Subnet mask: |255.255.255.EI

¢ Usze router

[ Usze different method to obtain [P address Address 192 168.0.1

Subnet:
-- it hetwarked - Mew... |
Properties. . |
Delete |

Cancel | Help |

Figur 4. SIMATIC Manager> Hardware configuration >Ethernet interface

e Som figur 4 visar sa bockades "Use router” for och ett nytt Subnét lades
till via ”’New” knappen. Dérefter bekraftades alla dialogrutor med "OK”
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3.2.3 Konfigurera webbservern
e For att aktivera webbservern, automatisk uppdatering och i vilket sprak
webbservern ska visas i sa dubbelklickades det pa CPU och sen valdes
webbfliken dar dessa bockades for.

Properties - CPU 314C-2 PNJ/DP - (RO/S2)

CyclesClock, Mermary ] Retentive kemarn ] |Rterrupts ] Time-of-Day Interuptz | Cyelic Intermipts ]

General ] Startup ] Synchronous Cycle [ntermipts ]
Diagnostics/Clock, ] Frotection ] Communication Wehb
[v Erable ‘Web server an this module [ Allow access only wvia HTTPS
Languages ho be Loaded on the CPU Autamatic: Lpdate
Select up to 1 languages: v Activate Update interval:
v English [United States) 1z s

Dizplay Clazses of the Meszages

W 00 v 04 |» 08 | 12 v 1E
W 01 w05 w03 |wi13

W02 Wos W10 v 14

W 03 07 W11 v 15

dzer lizt:
User Rights Add. |
Edit.. |
Delete |

k. | Cancel | Help |

Figur 5. Webbfliken i CPU installningar
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o | webbfliken las en ny anvéandare till med l&s- och skrivréttigheter till

CPU via webbservern med ”Add”-knappen.
Edit User Entry and Password

%]

IJzer Hame: |user

The uzer can...

v Query diagnostics

v Read variable status
v Fead varable table

[v Call uzer-defined pages

E dit paszwiord

Pazgword:

Confirmn password;

Figur 6. Lagg till anvandare

[v wiite to uzer-defined pages

PR

PR

Cancel |

Help

e Nar installningarna stallts in sasparades och kompilerades de i CPU.

3.2.4 Symboler och S7- program

e [ ”Symbols” under ”’S7-Program” finns variabelnamnenligt figur 7.
=l §7 Programi1) {Symbols) -- webmotorASIMATIC 300{1)3CPU 314C-2 PN/DP

FEX

Statuz | Symbal Address Diata type Comiment
1 m M 1500 |BO0L Alamerns status
2 AP ek FC 1 FC 1
3 AAPMemary Mo1150  |BOCOL
4 AiPMotor! Mo160  |BOCL
5 AiProtorskydd Mo1731  |BOCL
B AVPReset_Knapp M 1170  |BOCOL Web servernz resetknapp
7 APStart Mo 1000 |BOCL
g APStop Mo1001  |BOCL
] hctort @ 1360 |BOOL Motor status
10 Motarskycd | 1362 BOCL
11 pulzt Mo 179.0  |BOCL pulz1
12 puls2 M 1806 |BOCL
13 puls3 Mo 181.0 |BOCL
14 puls4 Moo181.2  |BOCL
15 Reset_knapp | 1363 BioCL
16 Fh_Speed G 1381 BiCL Hastighet till frekvensomriktare
17 Start | 1360 BOCL Start Knapp
18 Start_remate M 1804 |BOCL Wish serverns startknapp
19 Stop I 1361 BiCL Stoppknapp
20 Stop_remote M 1805 |BOOL Wb serverns stoppknapp
21 tag_4 Mo170.0  |BOCL
22 Tay_5 Mo1701  |BOOL
23 WEBCaontrol_DB LB 333 CE 333
24 WighReguest SFC 99 SFC 99
25

Figur 7.Tabell for variabelnamn i SIMATIC Manager
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e Under ”S7-Program” > ”Blocks” lades ett block, OB1, med Ladder till.
En del av koden framgar av figur 8.

H180_5
Meh H150_0
Il136_0 SEFWerns Alamerns 0136_0
Start H172_0 stoppknapp I136_1 status Motor
FErnapp pulsl "Stop_ Stoppknapp "Alarm status
"Start" "pualsl" remote" "Stop" minne ok" "Motorl"
| | {p} /1 /1 | | { —
n136_0 0136_1
Motor Hastighet
status till
"Motorl" frekvenson
I I riktare
"Ph_Speesd"
H180_ 4 {} I
L=Y ]
EErVEarns
startknapp
"Start_
remote"
| |

Figur8.57-300 SIMATIC Manager. En del av kodeni OB1

e Tva nyablock lades till, i ladder respektive STL. ”Blocks” > "Insert new
object” > function”. | den enadrogs ett SFC99 block ut ur standard
biblioteket i vénstra sidomenyn och det blocket fick namnet SFC99. Det
andra kallades FC1 och figur 9 visar dess kod.

Comment. :

CALL "WebRecuest"
CTRL_DE:="WEEControl DE"
RET_VAL:=§5FCState_ 333

SFCo9

DEZZ2

$EFCitate 333

HOP i}
Comment :
L #53FCState_333 $EFCEtate 233

ATT THlega0lo

EE

Figur 9. SIMATIC Manager Block FC1
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3.2.5 Lanka samman HTML-sidorna med S7-programmet

For att binda HTML-sidorna med programmet anvandes ett tillaggsom
kallas ”S7-Web2PLC”. Den fanns under ”Block folder” > "S7-
Web2PLC”. ”S7-Web2PLC” kriavde separat installation, se kapitel4.5.2

Ett nytt projekt skapades genom File” > "New Project” och doptes till
“Example”.

Variabelnamnen i figur 7 exporterades med "Export symbols”.

Den specifika mappen dar HTML — sidorna sparades angavs i “File” >
’change project settings” under general fliken. Déar angavs ocksa vilken
HTML-fil som angavs som startsida. Applikationsnamnet sattes till

29 29

€X',

Alarmvardena sattes i Enum fliken. Tva enum vérden skapades genom
”New” > ”AlarmValue” och ’AWPMemoryVaule”. Alarmvérdena har
tva tillstand var. De lades till genom Insert enum value” dar dven

“ENUM text” angavs.
I Project Settings )X

General | Parser | STEF 7 EMUM types | General | Parser | GTEP7 ENUM types |

EMLIM

ENLIM 1] Insert enum value |

EMUM value | EMUM bext ENUM value ‘ EMLIM text
0 Mator circuit breaker 0 *ou need to reset!

Figur 10. S7-Web2PLC Enum typer

DB333 och DB334 genererades genom “Generate DB Source”. Darefter
kompilerades de och laddades ned till CPU.

Genom att markera "SIMATIC 300(1)” och sedan klicka pa
”Download” symbolen si laddades hela projektet ned 1 CPU.
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3.3 Android Applikationen

Vid utveckling av applikationer for Androidtelefoner anvandes féljande
program; Eclipse med ADT plugin, Android SDK Tools och Android
Platform-tools [4]. Dessa fanns som ett fardigt paket pa Androids egna
hemsida och var gratisatt ladda ner.

Detta kapitel kan anvandas som en lathund till hur en applikation skapas for
anslutning till webbservern som ndmns i kapitel 3.1 och 3.2. For djupare
forstaelse hanvisas lasare till kapitel 3.5.

3.3.1 Tillvagagangssatt
e Via ”File” > ”New” > ”Android Application Project” skapades ett nytt
projekt.

o Ett element av webview deklarerades i activity layout”.
a0 activity_mainsmml 5

<?xml version="1.0" encoding="utf-g"7>

<MebView wmlna:android="kttp:/ schemas. android, com'apk/res/ android”
android: id="@+1d/ webviaw"
android: layout width= "fill_parent "
android: layout height= "fill_ parent"

i

Figurll. Activity_main.xmli Eclipse

e Ett webView element skapades i ”MainActivity.java”. Med funktionen
loadUrl(http://...”) sa laddades den 6nskade HTML-sidan och med
setJavaScriptEnabled(true) sa kunde HTML - sidan som webView
ansluts till anvanda javaScript.

e Projektet fick tillatelse att anvanda internet i AndroidManifest.xml.
a1 57-1200 Manifest &2

<?umwl wersion="1.0" encoding="utf-Sros

<manifest mmlns:android="http: S schemas. androlid. com/apk/res/android"
package="com. exampl . wehh"
android:versionCode="1"
android:versioniame="1.0" =

<uses-permizsion android:name="znrdroid. permission. INTERNET" />

Figur 12. AndroidManifest.xmlinternetaccess med “android.permission.INTERNET”
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e En ny klass MyWebViewClient som &r en subklass till WebViewClient
skapas och anropas "MainActivity.java”.

e En emulator skapades 1 ”"Window” > ”Android Virtual Device
Manager”. Med "New” knappen lades en ny emulator till.

e Applikationen testades genom att hogerklicka pa projektet, ”Run as” >
”Android Application”. D4 kompilerades projektet och emulatorn
startade.

3.4 User defined webpage

For detta projekt skapades tre stycken HTML-sidor i Notepad++ for styrning
av den programmerade motorn i PLC. Sidorna som kodades doptes till
index.html, loginPage.html och controlPage.html.

Kodexemplen ar markerade i kursiv stil dar ’taggar” ar fet markerade.

3.4.1 Generering av HTML-sidor

e Via ”Arkiv’ > "Ny” skapades och sparades en ny sida som en HTML
fil. Tre stycken filer gjordes pa samma sétt.

e For att kunna komma at PLC tags” deklarerades foljade rader ovanfor
<html>"taggen”:
<!-- AWP_In_Variable Name=""AWPStart™ -->
<!I-- AWP_In_Variable Name=""AWPStop"" -->
<!-- AWP_In_Variable Name=""AWPMemory"" -->
<I-- AWP_In_Variable Name=""AWPMotorl™ -->
<!-- AWP_In_Variable Name=""AWPReset_Knapp"'-->
<!-- AWP_In_Variable Name=""AWPMotorskydd™" -->

e Med hjalp av >’AWP commands”’kunde 6nskat "tag” skrivas ut pa en
specifik plats i HTML sidan. Ett exempel pa det ar:
<p> Motor value: </p><p>:="Motorl ”:<Ip>

Via ett formulér i HTML kunde en knapp kodas som utférde dnskad
funktionalitet. Nedan foljer ett utdrag fran controlPage.html dar Start-
knappenskodning framgar:

<form method="post" action="">

<input value="Start" type="submit" style=" width: 100%">

<input name=""AWPStart"""* value="1" type="hidden">
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<input name=""AWPStop""* value="0" type="hidden">
<input name=""AWPReset_Knapp'"" value="0" type="hidden">
</form>

Alla HTML filerna, CSS filen samt bilderna sparades i en och samma mapp.

3.5 Fordjupning av Installningar

Detta kapitel forklarar vad sarskilda delmoment i tillvagagangssattet har for
funktion. Har forklaras mer detaljerat varfor utvalda punkter utfors.

3.5.1 S7-1200

Vid generering av “Web control DB” skapas DB blocken och dér lagras all
styrinformation fran HTML sidorna. Déarefter anropas WWW instruktionen
med DB blocken som inparameter. DB blocken kan hittas i programblock
mappen i projekts navigationstrad dar den kan modifieras [16].

For att ”User defined web pages” skall vara tillgdngliga kravs en "WWW?”
instruktion. WWW instruktionen maste darfor inkluderas och exekveras i OB1
som alltid anropas.Varje gang det blir en andring i webbservern sa andras ett
DB block vilket medfor att i ndgon utav DB blocken da kommer den &ndrade
blocket att vara en inparameter till "WWW? instruktion och dndrar DB varde
[10].

Webbservern kan endast tilldela varden till minnesceller i programkoden.
”AWPStart” och ”AWPStop” dr dérfor minnesceller som fér sina virden fran
webbservern. Dessa kodas seriellt med ”Start remote” respektive

”Stop remote” med en pulsgenerator. I figur 8 kodas ”Start _remote” parallellt
med ”10.0Start” for att motorn skulle kunna startas bade fran webbservern och
manuellt. ”’Stop remote” kodas seriellt med ’10.1Stop” for motorn ska kunna
stoppas antingen fran webbservern eller manuellt.

3.5.2 S7-300

CPU tilldelas en IP adress fran routern som har det subnéatet som laggs till med
”New” knappen. For att det skall vara mojligt att komma at webbservern sa
maste enheten som vill kommunicera ligga under samma subnat. | figur 4 &r
subnétet 255.255.255.0.

Variabelnamn tilldelas for att binda samman namn och logiska operatorer
samt for att underlatta felsokning da de ar kommenterade. Tabellen ger en
overskadlig blick 6ver programmet vilket gor det lattare for utomstaende att
forsta koden.
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For att kunna skapa ”User Defined Webpage” krdavs en separat installation av
”S7-Web2PLC” som ligger under STEP 7 DVD V5.5 1 CD 2 under ”Optional
Components”. Paketet &r integrerat med CPU och gor det mojligt att binda
samman HTML sidorna med variablerna i CPU . Den skapar DB block som
innehaller koden fran HTML — sidorna. Med SFC 99 synkroniseras
webbapplikationen med CPU. Ett "Web control DB” innehaller all vasentlig
information om webbapplikationen. Det maximala antalet DB block ar 16
inklusive "Web control DB” [11].

3.5.3 Android

WebView dr en klass i Android SDK som visar en vy av webbsidor. Klassen
har till grund att visa en webbsidas innehall i en aktivitet. Den anvander
Androids egna WebKit for att visa webbsidor och dar finns funktioner som
gor det mojligt att anpassa sidan till mobiltelefonen. Anvandaren upplever inte
applikationen som en webblasare da inga adresser eller laddningsfalt
férekommer [12].

loadURL(http://...”)ar en funktion som anropas sa fort applikationen startar
vilket startar upp den URL sidan som star skriven mellan citattecknen.

3.5.4 HTML

”Meta tags” anvinds for att anpassa HTML sidorna till skdrmen pa
mobiltelefon. Koden nedan anvandes for att anpassa sidan till mindre skéarmar.
<meta name="HandheldFriendly" content="true" >

<meta name="format-detection" content="telephone=no" />

<meta name="viewport" content="user-scalable=no, initial-scale=1,
maximum-scale=1, minimum-scale=1, width=device-width, height=device-
height, target-densitydpi=device-dpi" />

”Automation Web Programming”, AWP, har hand om syntaxen mellan
HTML sidorna och webbservern. Det ar Siemens egna programmerade sprak
som binder CPU taggarna” med webbsidorna. Inom AWP finns det olika
funktioner som anvénds for kommunikation. L&sa, skriva, och satta enum
varden &r tre exempel. ”AWP commands” kan placeras var som helst i HTML
dokumentet men for tydlighetens skull sa placerasde i borjan av HTML sidan.
Det ar viktigt att tinka pa att det dr tag” namnet som anvands vid anrop och
inte adressen.
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Ettexempel pd en AWP “command” som ska lasas kan deklareras pa foljande
satt:

<!I-- AWP_In_Variable Name=""AWPMotorl" -->

3.6 Kallkritik

All information som anvants till PLC installningar och funktioner finns att
tillgd pa Siemens hemsida. Information fér mobilapplikationen hamtades fran
Androids officiella hemsida. Det medfor att denna rapport &r trovardig.
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4 Analys

| detta kapitel beskrivs forstudier och l6sningsforslag till att kommunicera
med S7-300/1200. Den metod som valdes beskrivs i kapitel 3 Metod.

4.1 Forstudie

En metod for att styra S7-1200 tradlost via en Ipadhittades i vilken Siemens
utnyttjar deras egen webbserver.Darmed valdes den metoden nér
kommunikationen mellan S7-1200 och Android upprattades.Manualer i pdf-
format fanns pa Siemens hemsida att tillga for att aktivera webbservern.

Det var inte lika tydligt for oss att S7-300 hade en Szt

& all B:4Z ™

integrerad webbserver som kunde anvandas pa vy ¢
samma satt som pa S7-1200. Efter att ha pratat med — [SE  sens |
Siemens Sverige sa blev det inte tydligare och da

fick andra metoder undersokas for oo SN B

tillampning.Sokning pa nétet gav resultatet att med
ett OPC program som Oversétter data sa kan en
dator anvandas som mellanled mellan PLC och
mobil-telefon.Hur billig PC skulle kunna anvandas?
Den billigaste vi provade var
LinuxbaseradeRaspberry P1.Det gick att skapa en
databas i den billiga PC som Android kunde skicka

varden till men det fanns inga OPC program som Figurl3. Prototyp i emulatorn

funkade for Linux. En vanlig Windows PC valdes ~ PaAndroid applikation till 7-
0 300 som skickar varden till en

och ett stort antal OPC program valdes bort pa grund  gepyer

av hogt licenspris.

4.2 Alternativa metoder

AF Industry har licens till WinCC Flexible vilket var anledningen till varfor
detta program var intressant for oss. Den innehaller bl. a. en funktion som
kallas ”Sm@rtAccess” vilket mojliggor for en extern enhet att komma at
“tags” i en HMI-panel via Ethernet. Licensnyckeln for denna funktion var det
billigaste alternativet d& AF redan har licensen for sjilva programmet.
Kommunikationen i denna metod sker 6ver SOAP[18].

MatrikonOPC ” Siemens S7 PLC OPC Server for Siemens PLCs” mojliggor
Ethernet kommunikation for lattare atkomst for PLC data pa distans. Denna
OPC server ar Windows baserad program vilket gor att man maste kora via en
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PC med Windows operativsystem for att kunna komma at PLC data.
MatrikonOPC erbjuder flera anvandargranssnitt méjligheter sa som HM,
Databashantering, Webbapplikation m.m. Detta alternativ valdes bort for att
MatrikonOPC kréver for hogt licenspris for sin OPC server [13].

PhoneGap é&r ett applikationssprak som utnyttjar standardbaserad webbteknik
och &r gratis att anvanda. Pa grund av den tekniken blir PhoneGap
operativoberoende plattform vilket menas att man kan utveckla en applikation
till alla operativsystem som finns idag som till exempel 10S, Android och
Windows Mobile. PhoneGap forsoker ta bort onédiga trosklar som finns i
dagens applikationsutveckling som olika programmeringssprak som anvands
for de olika operativsystemen.PhoneGapkodar applikationen i HTMLS5,
JavaScript samt CSS3 [14].
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5 Resultat
| detta kapitel sammanstalls alla resultat som uppnatts i kapitel 3 Metod.

5.1 Webbservern

Det fungerade att aktivera webbservern i S7-1200 for att fa fram de 6nskade
resultaten vilka var att mobiltelefonen kunde ansluta till webbsidan. Android
applikationen i mobiltelefonen kunde genom enbestamd IP adress komma at
de anpassade HTML sidorna ”User defined webpage” vid start av
applikationen. Med vald metod fick arbetet en Iag utvecklingskostnad da bara
redan innehavande licenser utnyttjades.

5.2 Applikationen

For att kunna styra motorn maste anvandaren logga in
och sedan klicka pa ”Control Page”. Vill anvdndaren Main Menu
inte styra eller om denne saknar rattigheter sa ar det
mojligt att 14sa varden fran motorn i ”Control page”
utan losenord. ”Control page” ser likadan ut om “
oavsett om anvandaren ar inloggad eller inte,
skillnaden &r alltsa vilka rattigheter denne har. Vid
inloggning sa klickas ~Login”och anvindarnamn
medldsenord skrivs enligt figur 18 i kapitel 6
Diskussion. Foér att kunna styra motorn klickar
anvindaren pa ”Control page” dar applikationen kan
starta, stoppa och aterstélla med “Reset” ifall alarmet
har utlost. Sidan laser aven av vérden fran motorn déar
gron figur sidan om motor value” indikerar pa att

motorn &r igang och rod pa att den star still. Ett Figur 14. forsta sidanav S7-
alarmvarde och reset status finns att lasa av som 1200 _
skriver ut om ett alarm har 16sts ut och om alarmet applikationen vid start

behover aterstallas.
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| figur 15 star motorn still d& alarmet “Motor circuit
breaker!” har utlgsts. Om anvéndaren vill starta
motorn maste forst alarmet atgardas och sedan
aterstallas for att sedan kunna starta motorn igen.

24

Control page

Motor value:
Alarm status: Motor circuit breaker!

Reset status: You need to reset!

“

Figur 15. Control page for
S7-1200.

Motorn star still, "Motor
value” dgr rod



6 Diskussion

En Android baserad mobiltelefon kan kommunicera med en Siemens PLC S7-
1200. Mobiltelefonens operativsystem har ingen betydelse sa lange telefonen
har en webblésare som kan lasa HTML sidor.Det &r da mojligt att bade skriva
och lasa av nya varden fran enheterna som ar kopplade till S7-1200. I figur 15
”Control page” styrdes motorn av digitala virden sd som 1’ och ’0’ men
motorn kan dven ta emot och skicka analoga viarden som ’15” och *200’ for
motorns varvhastighet .

Samma applikation kunde anvéndas for S7-300 som for S7-1200. Skillnaden
var att pa S7-300 applikationen sa 6ppnas PLCns egna hemsida déar
anvandaren forst maste logga in pa Siemens webbserver for att sedan klicka
sig vidare till de anpassade webbsidorna ”User defined webpage” via en ldnk
som figur 17 visar.

Figur 16 Emulatorns forsta sida av Figur 17 Lank till de anpassade
S7-300 applikationen vid start webbsidorna

Applikationen som skapades for Android kan &ven skapas for 10S — enheter
men kraver lite kunskap om “Objective C” vilket ar det spraket som Apple
kodar sina applikationer med [15].
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Siemens har en ”FormLogin” fil som kontrollerar
inloggningen i webbservern. Den filen kunde inte
korrigeras av sakerhetsskal fran Siemens vilket

ledde till att inloggningen inte skedde pa det satt
som vi hade tankt oss. ”FormLogin” kontrollerar assword

ifall inloggningen lyckades och stannar kvar pa ]
sidan. Vi forsokte fa den att kontrollera
inloggningen och sedan skicka oss vidare till “ -
”Control page” utan att lyckas.

En sadan applikation som detta examensarbete
omfattar far inte ha hoga utvecklingskostnader,
detta var AF Industry tydliga med i bérjan av Figur 18. "Login page”
projektet. De alternativa metoderna valdes bort pa ~ 'or 57-1200.

grund av att de hade hoga licenskostnader och

kunden skulle betala for utvecklingskostnaden och

inte for tredjeparts licenser vid kdp av tjansten.

Déarfor valdes metoden for webbservern som

beskrivs i kapitel 4.

Motorn hade kunnat kommas at via routerns publika IP adress, dvs. utanfor
hemnétverket, men IT avdelningen pa AF ansag att det var riskfullt att tilldela
routern ett sadant sa det testades inte. Mojligheten finns och det &r upp till
varje foretag att bedoma riskerna. Ett alternativ ar att koppla PLC till en
sandare med ett abonnemang och via den IP adressen na webbservern. For att
fa en konstant adress kan foretaget kopa en doman som de namnger och
ansluter till nar de vill komma at webbservern. Racker det att komma at PLC
fran hemnatverket sa bestams en statisk lokal IP adress som applikationen
laddar upp.
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7 Slutsats

Med applikationen som rapporten beskriver kan en maskinoperator ha koll pa
flera enheter samtidigt med mobiltelefonen. Operatéren kan fa alarm innan
nagot gar fel och stoppa maskinen pa distans for att sedan starta den igen néar
vardena har gatt tillbaka till det normala. Chefen pa produktionen kan genom
nagra knapptryck pa mobilen kontrollera sa alla stationer ar aktiva.

Varje applikation maste anpassas efter ett specifikt PLC program. Darfor kan
inte applikationen prisséttas och laggas ut pa ”’Google Play” for kunder att
ladda ner. Om en kund vill ha en applikation sa maste den skrivas pa nytt
enligt metoden pa kapitel 4. Ett pris kan inte heller sattas pa applikationen da
PLC program varierar i storlek och som med HTML — sidorna sa anpassas
priset efter PLC programmet.

Metoden med webbservern for S7-1200 blev den billigaste for AF Industry d&
webbservern aktiveras genom TIA Portal vilken AF har licens till. 1S7-300
anvandes ocksa webbservern pa grund av for hoga licenspriser d&ven om
metoder med béttre layout fanns.

7.1 Framtida utvecklingsmojligheter

For framtida projekt kan denna rapport anvandas for skapandet av
applikationer till enheter via Siemens PLC. Avancerade PLC program kan
styra flera enheter. Med egen definierade webbsidor som dessutom &r
mobilanpassade till en PLC sakan operatdren styra enheter tradlost via
mobilen utan att vara i samma lokala nét, t.ex. hemifran. Detta kraver storre
kunskap inom IT — sékerhet och autentisering for att inte riskera intrang och
manipulering av enheter.
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15.http://developer.apple.com/library/mac/#documentation/Cocoa/Conc
eptual/ProgrammingWithObjectiveC/Introduction/Introduction.html



http://www.afconsult.com/sv/Om-AF/Om-AF/
http://frapps.se/2012/05/22/smartphoneanvandande-i-sverige/
http://www.eclipse.org/org/
http://developer.android.com/sdk/index.html
http://notepad-plus-plus.org/
http://www.w3schools.com/html/
http://www.w3schools.com/css/css_intro.asp
http://www.java.com/en/about/
http://www.w3schools.com/js/
http://www.automation.siemens.com/mdm/default.aspx?Language=en&ShowMsg=false&DocVersionId=41524141835&GuiLanguage=en&cssearchengine=NEW
http://www.automation.siemens.com/mdm/default.aspx?Language=en&ShowMsg=false&DocVersionId=41524141835&GuiLanguage=en&cssearchengine=NEW
http://www.automation.siemens.com/mdm/default.aspx?Language=en&ShowMsg=false&DocVersionId=41524141835&GuiLanguage=en&cssearchengine=NEW
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&objId=22781365&load=content&lang=en&siteid=cseus&aktprim=0&objaction=csview&extranet=standard&viewreg=WW
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&objId=22781365&load=content&lang=en&siteid=cseus&aktprim=0&objaction=csview&extranet=standard&viewreg=WW
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&objId=22781365&load=content&lang=en&siteid=cseus&aktprim=0&objaction=csview&extranet=standard&viewreg=WW
http://developer.android.com/reference/android/webkit/WebView.html
http://developer.android.com/reference/android/webkit/WebView.html
http://www.matrikonopc.com/opc-drivers/opc-siemens-s7-plc/base-driver-details.aspx
http://www.matrikonopc.com/opc-drivers/opc-siemens-s7-plc/base-driver-details.aspx
http://phonegap.com/about/
http://developer.apple.com/library/mac/#documentation/Cocoa/Conceptual/Pr
http://developer.apple.com/library/mac/#documentation/Cocoa/Conceptual/Pr

8.2 PDF manualer

16.Manual for S7-1200, kan hittas direkt med pdf namnet eller via den
har lanken:
http://cache.automation.siemens.com/dnl/zA/zAXNDQ3AAAA 588
62931 Tools/58862931 S7-1200 Webserver DOKU v10 en.pdf
[Hamtad: 2013-06-17]
58862931 S7-1200 Webserver DOKU_v10 en.pdf

17.Manual for S7-300, kan hittas direkt med pdf namnet eller via den
har lanken:
http://cache.automation.siemens.com/dnl/TM/TMOODIzMQAA 442
12999 Tools/44212999 AWP PN CPU V10 e.pdf
[Hamtad: 2013-06-17]
44212999 AWP_ PN _CPU V10 e.pdf

18.Manual for "Sm@rtAccess”. Den kan hittas via programmet WinCC
Flexible genom att trycka pa ”about” och sedan klicka pa den pdf
filen som handlar om ”Sm@rtAccess”.
WCFO07WebFeaturesenUS.pdf

29


http://cache.automation.siemens.com/dnl/zA/zAxNDQ3AAAA_58862931_Tools/58862931_S7-1200_Webserver_DOKU_v10_en.pdf
http://cache.automation.siemens.com/dnl/zA/zAxNDQ3AAAA_58862931_Tools/58862931_S7-1200_Webserver_DOKU_v10_en.pdf
http://cache.automation.siemens.com/dnl/TM/TM0ODIzMQAA_44212999_Tools/44212999_AWP_PN_CPU_V10_e.pdf
http://cache.automation.siemens.com/dnl/TM/TM0ODIzMQAA_44212999_Tools/44212999_AWP_PN_CPU_V10_e.pdf

